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GUIDANCE NOTE ON COMPLETING THE TENDER PROPOSAL
FORM

As well as reading this Guidance Note, it is important that you read the LSC
London East Programme Prospectus which gives additional information on the
LSC London East programme. This is available from http://www.Isc.gov.uk/londoneast

Please ensure you complete all sections of the Proposal Form thoroughly as all the
information will be used to assess your proposal. Questions may be assessed, used
to determine eligibility or form part of the appraisal process. Assessment/eligibility
guestions are identified in the guidance by section below.

When completing your form, you will need to refer to the points awarded for each
guestion in order to ensure that you give appropriate emphasis to each question.

Your proposal must be word-processed. It is important that you read Annex 1
(Guidance on completing the electronic version of the tender proposal form)
before beginning work on the tender proposal form.

All sections must be completed. Do not leave a section blank: if you feel a
section is not relevant then explain this in the relevant section. You may
increase the size of sections as necessary, but the proposal form must not
exceed 25 pages (measured from Section 1B up to and including Section 8, but
excluding the questionnaires at the end of the proposal form and any blank
spaces). Any additional pages will not be assessed.

How to Submit the Proposal Form

Tenders must be received by LSC London East no later than 5pm on Friday 8
July 2005. European Commission guidelines on Open and Competitive Tendering
state that tenders received after this deadline cannot be accepted.

The onus is on applicants to prove that a tender was received before the deadline. If
the tender is hand delivered, LSC London East will issue you with a signed receipt
recording the date and time your tender was received. If you are posting the tender
you should send it recorded delivery so that the Post Office record the date and time
LSC London East receives the package and obtains a signature to confirm it has
been delivered. No electronic submissions will be accepted.

All tenders (and each photo-copy) must be signed. ONE original copy of the tender
proposal form, together with THREE photocopies must be submitted, along with one
copy of all the additional documentation required, to:

ESF Tender Proposal 2005
LSC London East
Boardman House

64 Broadway

Stratford

London

E15 INT



http://www.lsc.gov.uk/londoneast

The additional documentation, which must be submitted with your tender, is listed in
the checklist below.

Documentation Checklist
Copies or proof of the following documentation must accompany your application:

Letters of commitment from the three main partners

identified in Section 4A (if applicable to your project) m

Completed Equal Opportunities Policy Questionnaire m
- copy at end of Proposal Form

Completed Sustainable Development Questionnaire m

- copy at end of Proposal Form
Completed Health and Safety Questionnaire (HSQ1 Revised)
- copy at end of Proposal Form
Copy of latest signed Audited Accounts m
(where you are not required to have audited financial statements,
please supply accounts as submitted to the Inland Revenue,
other regulatory body or your bank)
Current Public and Employers Liability Insurance Certificates m
Copy of latest ALI/OFSTED or TSC report, if applicable m

O

NB If you do not send all the required documentation your proposal will fail
eligibility.

Proposal Application Checklist

Please ensure that you have:
Completed all sections and questionnaires m
Signed and dated the certification form in Section 8 m
(two signatures are needed: one from the person completing the tender
proposal form and the other from an authorised signatory e.g. Finance
Director, Chief Executive)

Signed and dated all three questionnaires at the end of this form m
Sent one original and three copies of the tender proposal form along
with one copy of all supporting documentation m

Please sign and date all relevant sections by hand, as the computer will not
allow you to do this electronically.

NB If your proposal is not signed, and if you do not send all the required
documentation, your proposal will fail eligibility.

Queries

LSC London East will be the contact for all queries from prospective and successful
tenderers. Contact details are as follows:



Telephone: 020 8929 3977

E-mail: esf2005londoneast@Isc.gov.uk

Address:

ESF Tender Proposal 2005

LSC London East
Boardman House
64 Broadway
Stratford

London

E15 INT

Website: http://www.Isc.gov.uk/londoneast

Whilst LSC London East will endeavour to provide full support on technical issues
(such as understanding what is required of LSC London East programme
specifications, the application process, eligible items of expenditure etc) it will not be
able to provide detailed support to tenderers on the validity or detailed content of
their proposed project or individual support to tenderers, such as help in writing their

tenders.

Assessment Framework

Full details of the assessment process are given in the LSC London East

Programme Prospectus.

The assessment sections are as follows:

Section Section in | Maximum | Weighting Total
Proposal Score Maximum
Form Score
Track record 1.C 4 2 8
Project objectives and fit with tender | 2.A 4 4 16
specification
Proposed activity, work plan and | 2.B (+ 3) 4 3 12
target groups
Key partners, partnership working, | 4 4 3 12
project management and risk
assessment
Value for money 5C(+5.A, |4 2 8
5B)
Quality assurance, monitoring and | 6 4 2 8
evaluation
Equal opportunities 7.A 4 3 12
Sustainable development 7.B 4 1.5 6
ICT 7.C 4 0.5 2
Total 84



mailto:esf2005londoneast@lsc.gov.uk
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Assessors will use the following framework in scoring the assessment sections.

Scoring Framework

Score Validation

4 The information provided fully addresses the question in line with the
specification/guidance

3 The information provided significantly addresses the question in line
with the specification/guidance

2 The information provided partially addresses the question in line with
the specification/guidance

1 The information provided fails to address significant elements of the
specification/guidance

0 The information provided does not address the question in line with
the specification/guidance or no information is provided

Following eligibility checks, the assessment of the proposal form comprises the first
stage of the appraisal process. A range of other factors will then be taken into
account by the moderation panel as described in the LSC London East Programme

Prospectus.

The information that is required for each section is described in the Guidance by
section which follows. Each question indicates if it will be assessed (identifying the
number of points), form part of eligibility checks or be used for information only, as

follows:

I Information only

E Question will be used to determine eligibility

A: 8 points Question will be assessed and given up to 8 points (including

weighting)




GUIDANCE BY SECTION

SECTION 1: PROJECT SUMMARY & APPLICANT DETAILS
Section 1.A: PROJECT SUMMARY | AND E

Applicant Organisation Name: Please write the registered name of the lead
applicant organisation (the organisation that will be accountable for the funding) here.
Please note that that the applicant organisation must be legally constituted and that
sole traders are not eligible to be an applicant organisation. If you are a subsidiary, a
department or an outlet of a larger organisation, the applicant organisation will be the
name of the organisation that is acting as the accountable body.

Project Title: Please write the name of the project here. We will use this information
to identify your project in any correspondence sent to you.

Tender Specification Addressed: Please write the tender specification, for example
2.1a. This can be found in the LSC London East Programme Prospectus. Please
note that your project must meet ONLY ONE of the tender specifications in the
Prospectus. You must complete a separate proposal form for each specification that
you wish to bid for.

Project Start and End Dates: Please identify the start and end dates
of your project. The start date can be from October 2005, and the
end date can be no later than March 2008. Within this time-frame
your project can deliver for a maximum of 2 vears, or 8 quarters,
and vyour tender application must reflect this. For example, a project

running from October 2005 to September 2007 is valid; however a project that starts
in October 2005 and ends December 2007 is invalid.

NB If your dates fall outside of this period your project will fail eligibility.

Project Summary: Please write a brief description of the project in no more than
100 words, which detalils:

the objectives of the project and its potential impact;

the activity you will be delivering and key outputs and milestones; and

the client group you will be working with.

The project summary will be used in reports compiled for the appraisal panel and for
any publicity conducted by the LSC London East programme. Please make clear
which beneficiary group you are dealing with and that it fits with the specification you
are applying for.

Three main partners: If applicable, please list the three main partners to the project.

Financial Summary: These details will be auto-completed once you complete
Section 5B.




Key Outputs, Outcomes and Beneficiaries: Note: an ‘Output’ and ‘Outcome’ are
considered to be synonymous.

Overall number of beneficiaries/number of beneficiary organisations:

These boxes will summarise what your project will deliver. According to the
specification you are tendering for, your project will deliver either to both beneficiaries
and organisations, or solely to beneficiaries. Alternatively, if your project is a capacity
building project, you may solely be working with organisations. Please complete
accordingly.

Summary table

In this table, please summarise all the achievements that your project will produce.
These may be beneficiary achievements, qualifications or capacity building
outputs/research reports, depending on your project. Use the ‘Other Key Output’
rows to show any outputs not listed.

If you are delivering non-accredited qualifications, units towards an NVQ, or NVQs in
more than one subject within the same level, you can enter the required details by
creating an extra line within the appropriate row. To do this, place your cursor inside
the appropriate row and press ‘Enter’ on your keyboard.

Please see the guidance accompanying Section 2B for a definition of the terms
‘output’ and ‘milestone.’

Section 1.B: APPLICANT DETAILS E

Please complete all the questions in this section.
Applicant Organisation: This will be auto-completed from Section 1A

Contact Person: The contact person must be someone who has been involved in
putting together the proposal.

Type of Organisation: Please mark a cross in one box only.

Organisation Leadership: We ask about the make-up of your management
committee in order to ascertain whether your organisation is led by one of the groups
listed. It is for information only and will not affect the assessment of your tender.
Please mark a cross in one box only.

Existing LSC Provider: If you currently have a contract with a Learning + Skills
Council anywhere in the country or have had one in the past 2 years, you should
answer YES and give the name of the relevant LSC(s). This is for information only
and will not affect the assessment process.

Section 1.C: TRACK RECORD A: 8 POINTS



Please describe projects that you as the applicant organisation have worked on that
have delivered similar activity and outputs and describe your previous relevant work
with the target groups you wish to support in this project.

Please also describe any relevant experience that your key partners have in
relation to the relevant activities and target groups.

Finally, please describe any relevant experience you as the applicant organisation
have had of managing ESF or other projects of a similar scale and complexity, if this
is relevant to this application.



SECTION 2: THE PROJECT
Section 2.A: PROJECT OBJECTIVES AND FIT WITH TENDER SPECIFICATION A: 16 POINTS

This is the highest scoring section of the Proposal Form.

Please describe the project's objectives here. Please make sure you describe
objectives and not aims and ensure that they are SMART (Specific, Measurable,
Achievable, Realistic and Time-bound). Your proposed activity and work plan
(Section 2B) should relate to the objectives you have identified. Please ensure that
the objectives are clear and appropriate for the specification under which your
proposal is submitted. Do not simply repeat the specification details.

Please then describe how your project’s objectives, activities, outputs and milestones
fit the tender specification under which you have submitted your proposal.

Section 2.B: PROPOSED ACTIVITY, WORKPLAN AND TARGET GROUPS A:12 POINTS
In this section you must cover:

What activity will take place at each stage of your project. Within each stage,
each activity must be Specific, Measurable, Achievable, Realistic and Time-
bound (SMART). For example for the set up phase you might include
recruitment of x staff, setting up steering group and partnership management
arrangements, marketing of programme; for the training delivery stage you
might include recruitment of x beneficiaries, delivery of x training for x weeks
to x beneficiaries, delivery of x support to x beneficiaries, etc. etc.

How, where, when and by whom the different stages will be delivered.

Who the project client group(s) are. Please be specific and ensure your client
group(s) meet the requirements of the tender specification under which you
have submitted your proposal.

How you will target, recruit and support beneficiaries. (If specialist support is
required please ensure that this is reflected in your costs.)

What outputs will be delivered (please see below for a definition of each of
these terms). The key outputs in the tender specification must be included. For
gualifications remember to describe the NVQ level (or equivalent), and the

subject area.

How the activity will continue after the funding ends or why it is not intended
that the activity will continue. Will you try to find other funding for the project
activity after this project period? What sources will you approach for funding?
If you expect the project to close at the end of the project period, what strategy
do you have in place to ensure that project closure occurs effectively?



How your proposed activity complements and does not duplicate existing
activity in the area covered by the project

If your project is part of a wider project you must explain the relationship
between the two projects and indicate if the ESF project is dependent on the
rest of the activity being funded.

Please complete the workplan (page 8) for the project as follows:

NOTE: Your project can deliver for a maximum of 2 years and your workplan
(page 8) must reflect this, with outputs or milestones shown in maximum of 8
of the quarters.

Result of activity . ) .
undertaken Use this column to describe the measurable achievements

(Outputs/Milestones) during the life of your project. This is very important as under
co-financing, the LSC pays providers for achievements rather
than for actual costs incurred. Applicants are therefore asked
to set out these achievements here and this will form the basis
of contract negotiations with the LSC on how the provider will
be paid. The LSC may eventually require you to add some
achievements to your payment profile.

Crucially the outputs listed in the tender specification *Section
2 of the Prospectus) must feature in this workplan.

You must be very clear and specific about the outputs,
outcomes and milestones that you plan to deliver as
substantial changes to projects once approved are not
possible.

Note: an ‘Output’ and ‘Outcome’ are considered to be
synonymous.

Outputs/Outcomes are things produced as a result of an
activity or are the end results of activity (e.g. beneficiary starts;
capacity building activity; businesses supported; NVQs
achieved; work placements; beneficiary moving into further
training or employment etc.) and Milestones are stages
towards the achievement of these outputs (e.g. development of
materials; appointment of staff; publicity / marketing).

Soft outcomes can be included here but all outputs and
milestones must be measurable.

For projects including learners some achievements are
mandatory and these are listed below:

Monthly/quarterly beneficiary starts

Qualification achievements

If your learners will be achieving qualifications state in this



Quarters/Planned
delivery (volumes)

section the name of the qualification, the level, and the
awarding body. If your learners will be achieving qualifications
or certificates that are not NVQs or are equivalent to NVQs
then give the name of the qualification and its level and
awarding body.

Due to the variety of projects, there will be many other outputs
/ milestones that can be listed and this is not a definitive list.
You should try to capture the key measurable achievements
and enter no more than ten in this section.

These columns break your project into 3-month periods. You
are asked to track the outputs you have described in the
previous column that will take place in each quarter. The
number of outputs being achieved in each quarter should be
recorded. Milestones will not always be measurable in humeric
form and therefore should be recorded by the letter ‘M’ in the
guarter in which the milestone will be achieved.

10



SECTION 3: TARGET GROUPS E AND ASSESSED AS PART OF PROPOSED
ACTIVITY AND WORKPLAN SECTION

This section refers to individuals, organisations and sectors. A beneficiary can refer
to any organisation or person that will benefit from the project. Please complete this
section in relation to the type of client your project intends to work with. We are
looking for indicative numbers of individuals/ organisations, which correspond to
those detailed in the tender specification.

NB: If the target groups in your bid do not match those in the tender
specification your bid will fail eligibility.

Capacity building and research-based projects may not have direct beneficiaries. If
this is the case please leave these sections blank.

NB: Please cross check that the information in Section 3 is consistent with that
entered into Section 2B.

Section 3.A: PARTICIPATION

Beneficiary Numbers - Gender, Employment Status, Age and Ethnicity

Please complete the tables which ask for information about the estimated number of
beneficiaries you will be working with, broken down by gender, employment status,
age and ethnicity. The totals in each of these four tables should be identical — the
computer will alert you if they are not.

Target Group

Beneficiaries may be entered more than once in the target group table if they fall into
more than one category. However, the computer will alert you if you enter a figure
larger than the total number of beneficiaries in any of the rows within this table.

Sector Focus
If your project is sector specific, i.e. retail, construction etc., please provide details of
the percentage figures for each sector you intend to work with in your project.

Business Size
Please complete this table if your project is working with businesses/organisations.
Voluntary and community organisations should be included in this table if applicable.

NB: the LSC London East programme will only support SMEs — no large employers
will be supported.

Geographical Coverage

Please indicate which boroughs you will be working in and the approximate % of
people/organisations to be supported in each borough. Please note that a
minimum of 80% of project beneficiaries must live, work or learn within the
catchment area of the local LSC to which the application for funds is made. The
computer will automatically calculate the total percentage you enter under each LSC
area and will alert you if this total is over 100%.

11



Section 3.B: BENEFICIARY PROGRESSION ROUTES

Please explain what will happen to the beneficiaries after their involvement in the
project (e.g. further training, employment etc.). Please also show how you will ensure
that beneficiaries have clear options for progression and how this will be managed.

Section 3.C: NON BENEFICIARY OUTPUTS

Some of the tender specifications will indicate non-beneficiary outputs. Even where
this is not the case, non-beneficiary outputs can add value to your proposal and
increase the opportunity for your project to make an impact.

Please detalil all non-beneficiary outputs in the table. You should count each output
once only. For example, if you produce one new study you should count this as one
and not multiply it by the number of copies produced.

For non-beneficiary outputs which are not listed, please enter the expected number

of these in the ‘Other’ row within the main table and then specify the nature of the
output in the box below the main table.

12



SECTION 4: KEY PARTNERS, PARTNERSHIP WORKING, PROJECT MANAGEMENT
AND RISK ASSESSMENT A: 12 POINTS

Section 4.A: KEY PARTNERS

In delivering your project, you may wish to work with other organisations. These are
known as partners.

Partners are organisations that are independent of the applicant, and will play a role
in the delivery or management of the project. They may either provide
complementary activities to achieve the project aims or deliver similar activity but
across different geographical areas. Partnership agreements are essential to make
clear each partner’s roles and responsibilities.

NB Subcontracting is not allowed in the LSC London East programme.

If you decide to form a partnership for the delivery of your proposed project you must
list your key partner organisations for this project in this section. Name the partner
organisation in the first column, state what type of organisation it is (please use the
list in Section 1B) in the second column, describe the role that the partner will play in
the project in the third column and confirm in the fourth column that you have
attached letters of commitment from the three main partners.

NB Failure to provide the letters will mean that the project fails eligibility.

Letters of commitment must be on partners’ headed paper and describe the
role/responsibilities the partner will be playing in the project. They must be signed by
a senior member of the partner organisation.

Please note that it is not an essential requirement of this programme that you form
such partnerships if you can demonstrate that your organisation can deliver the
project without doing so. Please refer to the guidance in section 4B.

Section 4.B: PARTNERSHIP WORKING

In this section, please outline your partnership approach and structure, detailing the
roles and responsibilities of the lead partner (i.e. applicant organisation), and the
contribution each of the key partners will be making to the project. If you feel that a
partnership approach is not appropriate for your project, because your organisation is
of a size and scope to possess all the necessary skills and capacity to deliver your
proposed project, please provide this explanation.

Please explain how the respective skills, knowledge and experience of the applicant
organisation and its partners complement each other and add value to the project.

If employers are not included in the project partnership, explain how the project
would create links with relevant employers.

Finally, please describe in detail what measures/processes you will put in place to
help ensure effective partnership working.

13



Section 4.C: PROJECT MANAGEMENT

In this section, you need to demonstrate that you have the capacity to manage the
project. Please tell us how you would manage the project to ensure successful
delivery of its activities, outputs and milestones.

Please describe your management structure for the project. Explain how possible
problems and conflicts would be resolved.

You need to explain the day-to-day management arrangements for your project,
including detailing who would be responsible for completing tasks in the following
areas:

administration and record keeping;

contract management and payment procedures; and

monitoring and evaluation.

You should explain how you will resource the management of the project and the
partnership. Please ensure that the resources required are reflected in the project
budget (Section 5).

Section 4.D: RISK ASSESSMENT

Please identify all possible risks to the successful delivery of the project, what
controls you will put in place to ensure that the likelihood of these risks occurring is
minimised, and your plans for dealing with them if they do occur. As the applicant
organisation is responsible for all aspects of contract compliance, you must have in
place mechanisms to ensure that partners to the project minimise risks to delivery.

Possible risks include the following:

Outputs and milestones are not achieved

Partners fail to deliver

Project timetable slips

Delays/difficulties in recruiting beneficiaries (type and/or volume)

Insufficient costs are allocated to key areas/budget overruns

No evidence of employer contributions to prove compliance with State Aid
regulations

Delays/difficulties in recruiting staff/suitably qualified or experienced staff or key
staff leave

Monitoring systems do not deliver

ICT systems are insufficient

Planned activities duplicate other provision

Innovative activities do not realise the impact originally intended.

This list is by no means exhaustive and you must seek to identify all appropriate risks
for your project.

14



SECTION 5: FINANCE

Section 5.A: COSTS ASSESSED AS PART OF VALUE FOR MONEY SECTION

The purpose of this section is to provide a clear breakdown of the costs you expect to
incur in delivering the activities and outputs and milestones you have detailed in
section 2B and section 3. Do not include costs that you will recover from any other
funding source.

The tender specifications in the LSC London East Programme Prospectus identify
the maximum budgets. You must ensure that your budget falls within the range
identified. If it does not, you must explain why (see section 5C).

Please provide the eligible costs for the project, broken down into staff, beneficiary
and other costs. You must ensure that the costs are realistic and justified, but also
that you have included all necessary costs, and budgeted for the whole period of
the project. Details of ineligible costs are covered in the LSC London East
Programme Prospectus. Costs must be inclusive of VAT where applicable.

NB Subcontracting is not allowed in the LSC London East programme. However
projects are permitted to buy in small specialist elements that the applicant/partners
cannot provide themselves (e.g. evaluation, specialist IT support). If in doubt contact
LSC London East prior to submission.

You should take particular care to budget for:
administrative costs associated with completing and submitting electronically the
ESF short record for beneficiaries of the project and for complying with other
contract requirements (further information is provided in the LSC London East
Programme Prospectus) and
management costs associated with managing the project and its partnership,
particularly if the project is large and complex.

Please give careful consideration to your budget as the LSC London East
programme cannot negotiate significant changes to the funding you are
offered after project approval.

Please ensure that all the calculations and additions are correct. We recommend

that these figures are checked by someone who has not been involved in developing
the budget.

STAFE COSTS

Job title and number of posts: enter the most appropriate job title to describe the
role of any staff who will be paid by the project to deliver the activities described in
Section 2. If you require more than one member of staff, indicate the number you will
require after the job title e.g. Learning Mentor x2. Job titles used should indicate both
the seniority of the member of staff (e.g. Director, Manager, Officer, Trainee etc) and
the nature of their role (e.g. project management, contract management, employer
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liaison, trainer/assessor, learner support, finance/Ml, IT support, marketing, research
etc). Use descriptions that are easily understood and unambiguous.

Employment status: enter one of the following: FT - Full Time, PT - Part Time.
% of time: indicate the percentage of time that will be spent working on the project.

£ funding requested:

The following method should be used to calculate this figure in pounds sterling.

For permanent and fixed term posts, identify the annual salary (plus National
Insurance and, if applicable, pension). If the post(s) is to cover more than one year
you should enter the average annual salary over the period of the project. Then
multiply this figure by the % of time the posts will spend on the project and the length
of the project. For contract staff, calculate the daily rate by the number of days they
will be contracted to work.

EXAMPLE
Job title & No of posts Employment % of time £ Funding
Status Requested
Project Manager FT 100% £70,000
Recruitment Officer (2) PT 30% £ 6,000
Total £76,000

BENEFICIARY COSTS

Description of cost: please list any project costs that will be paid directly to the
beneficiary for costs such as travel, childcare, costs of specialist equipment and
adaptations etc.

£ funding requested: enter the value in pounds sterling of the budget you require for
this activity. Complete the total for this column only.

Estimated number of beneficiaries: enter the number of beneficiaries that you
estimate will need this support.

Average cost per beneficiary: divide the funding requested by the estimated
number of beneficiaries.

EXAMPLE

Description of cost

Average cost
per beneficiary

Estimated No.
of beneficiaries

£ Funding Requested

Travel costs

£180

25

£4500

Total

£4500
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OTHER COSTS

Description of cost: please list any other costs that you will incur in delivering the
project. These can include, but are not limited to, recruitment costs, overheads,
minor repairs and maintenance/adaptation, capital items under £1000 (inclusive of
VAT), printing/stationery, insurance, hire of equipment and venues etc. Capital
items over £1000 (inclusive of VAT) are not eligible for ESF funding.

% of total cost charged to the budget: enter the percentage of total costs that are
being charged to the project budget.

£ funding requested: The following method should be used to calculate this figure in
pounds sterling.

Unless you are only running the LSC London East project, there may be a need to
apportion shared costs. If you have management and administration staff that
support different projects or have to charge overhead costs like rent, heating and
stationery to different projects, you must use an ESF-approved apportionment
method as described below. Enter the calculation you have used to work out the
proportion of the other costs to be charged to the project. Where 100% is being
charged to the project, provide a brief justification of this e.g. venue hire for project
only.

Apportioning shared costs using beneficiary hours

If the sole activity of your organisation is training, you must apportion any shared
costs using the beneficiary hours method. For this method you need to keep a record
of the total student hours delivered by the organisation, as well as records for the
LSC London East project.

For example, the LSC London East project delivered 2,000 hours in the first quarter.
Meanwhile, during the same period the whole organisation delivered 9,000 hours of
training (including ESF hours). Therefore, the calculation to allocate any shared costs
to the ESF project is:

2,000 X 100 = 22.22%
9,000

22.22% of the total of any shared costs can be allocated to the LSC London East
project.

Apportioning shared costs using staff time

If your organisation does not just deliver training, you can apportion costs using staff
time. You must calculate the time spent by staff working directly on the LSC London
East project and then all staff working directly on all projects.

Begin by calculating the number of hours a full-time member of staff works in a year.
Working hours will probably be something like the following (however, you may have
a different annual leave entitlement):

52 weeks x 5 days per week = 260 days

17



minus public holidays (8) and annual leave (25) = 227 days

Next, multiply the number of working hours in a day. For example, someone working
7 hours a day works 1589 hours a year. Adjust the formula accordingly for people
working part-time.

The following example shows how to apportion direct staff and overheads:

Firstly, calculate the number of hours of all staff working directly on projects (not
managers and admin staff as they are shared costs).

If you have a total of 6 full-time training and project staff, including the LSC London
East trainer, this represents 9534 hours (7 hours x 227 days per year x 6 staff =
9,534).

The time spent by the trainer on the LSC London East project was 675 hours, so to
create the apportionment figure to be charged to the project, divide 675 by the total of
training/project staff above as follows;

675 = 7.08%
9534

7.08% of all shared costs (admin / managers / rent / electricity / insurance etc.) can
be allocated to the LSC London East project.

Common apportionment mistakes include:

Organisations which are running three projects often simply divide shared
costs by three.

Organisations apportion on the basis of the number of students on the ESF
project as a percentage of the total number of beneficiaries within the
organisation as a whole. For example, an organisation may have 80
beneficiaries, of whom 10 are enrolled on an ESF project. It is not acceptable
to apportion on the basis of 10/80 = 12.5%.

Or, an organisation estimates shared costs with no evidence. For example,
“based on past usage, we estimate 34% of the phone bill is for this project”.

EXAMPLE
Description of cost % of total cost charged to £ Funding requested
budget
Rent 15.4% £4620
Recruitment 100% £3000
Venue hire 50% £2500
Total £10,120
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Section 5.B: FINANCIAL SUMMARY ASSESSED AS PART OF VALUE FOR MONEY SECTION

Total staff (a), beneficiary (b) and other (c) costs will be brought forward from
Section 5A. The total project cost (d) is the sum of (a)+(b)+(c) and will be calculated
automatically.

If your project is required to provide a contribution from an employer in order to
comply with state aid regulations, this must be entered into line (e). Further
information on state aid is provided in the LSC London East Programme
Prospectus. Please note that unless required to do so under state aid
regulations, the LSC London East programme does not expect any other match
funding.

Employer contributions may be in cash or in kind. If you are not receiving any
Employer Contributions please enter ‘0.’

The LSC funding requirement (f) is the total project cost (d) less any required
employer contributions (e). This will be calculated automatically once you have
entered the figure for Employer Contributions and pressed the tab button.

Leverage

Please complete the leverage table if you wish to bring in additional money in support
of your proposal which will count as ‘leverage’ against the proposal but not actual
match funding. This may add value to a proposal’s case for funding, as it will
maximise the use of public funds. However a proposal is not required to provide
additional money and it is accepted that this is not possible for many applicants.

Section 5.C: VALUE FOR MONEY A: 8 POINTS

The purpose of this section is to provide a clear rationale for the level of funding you
are requesting in Section 5.

You will need to explain how you have ensured that your project is good value for
money. Please do this by explaining how the cost is justified by the type of activity
and outputs to be delivered (for example, some client groups require more intensive
and high cost interventions to achieve outputs; you may be delivering additional
outputs to those specified in the tender specification). It is important to justify each of
the major costs listed under the headings of staff, beneficiary and other, especially
where these are higher than would be expected. You may want to further justify
value for money by comparing your costs to the costs of similar activity elsewhere.

If your total budget is different to the expected project size in the tender specifications
of the LSC London East Programme Prospectus you must explain why. As part of
the assessment process, your project’s unit cost will be compared to the average unit
cost for other projects submitted under the same specification. Explanation and
justification will be looked for in projects with higher (or lower) than average unit
costs.
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SECTION 6: QUALITY ASSURANCE AND MONITORING & EVALUATION A: 8 POINTS

Please give concrete examples of how you will ensure your project delivers a quality
service.

What systems will you put in place, what quality targets will you establish and how
would you monitor these? You should include any information around qualifications
that staff hold or staff training that might ensure quality of delivery for the benefit of
your clients.

Please state any recognised quality standards that you as the applicant organisation
holds or if you are working towards a recognised standard (e.g. Investors in People,
ISO 9001/2).

ESF regulations state that beneficiaries must be made aware of the ESF funding that
supports the project. The regulations also state that the ESF logo must be visible on
all materials to do with the project. The London Learning + Skills Councils require
that its logo is on all materials promoting projects linked with the LSCs. Please
describe how you intend to adhere to the publicity requirements of both ESF and the
LSCs.

Please describe the systems you will use for monitoring the project. Monitoring is an
essential management tool as well as an ESF requirement. Please include details of
the mechanisms you will use to monitor the project activities, outputs and finances.

Finally, please describe what type of project evaluation you are planning —
internal/external — and when this will take place - interim/final. You are required to
complete an evaluation as soon as possible after the project has finished (final
evaluation), but you will also be expected to undertake an ongoing or interim
evaluation to inform the project as it progresses. You may wish to use an external
evaluator.

You should evaluate all levels of the project — from the experience of people involved
in the project (including staff and working partners, as well as individual beneficiaries)
to the overall impact of the project. Further guidance will be provided to successful
applicants.
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SECTION 7: CROSS CUTTING THEMES

In this section you need to clearly outline how each of the cross cutting themes will
be taken into account in the delivery of your project.

Section 7.A: EQUAL OPPORTUNITIES A: 12 POINTS

Your project must comply with all current legislation on inequality and discrimination:
- The Race Relations Act 1976 and amendments

The Sex Discrimination Act 1975 and amendments

The Disability Discrimination Act Parts 1 - 4

The Employment Equality (Religion or Belief) Regulations 2003

The Employment Equality (Sexual Orientation) Regulations 2003

Legislation covers both the internal practices of the project and its staff, as well as
the manner in which the project activities are carried out. More detail on legislation
can be found on the Department of Trade and Industry website www.dti.gov.uk, and
on the websites for the Equality Commissions www.eoc.org.uk, www.cre.gov.uk and
www.drc-gb.org.uk

Projects should also be aware of forthcoming legislation on age discrimination and
should be committed to age equality within policy and practice. The government’s
campaign materials on age related discrimination can be found at
www.agepositive.gov.uk

European Social Fund projects should contribute to the London Equal Opportunities
Mainstreaming  Action Plan which can be found on  www.go-
london.gov.uk/european_structural funds/equalities

In this section please describe how you will incorporate equal opportunities into the
design, delivery and management of the project. You must also identify a strategy for
implementing equality of opportunity within your project. Your implementation plan
should show how the project promotes equality, and mechanisms for ensuring that
staff and beneficiaries understand the importance of equality. You should include
equality and diversity targets, linked to the equality aspects of the specification and
the project work programme, outputs and milestones. Please describe how you will
ensure that you meet these targets, and how the strategy will be monitored.

It is important that the LSC London East programme works with organisations that
are committed to breaking down barriers, and that everyone who wishes to engage in
the project is empowered to do so. You need to describe how you will promote
access to the project, in a manner sensitive to target groups’ needs (individuals or
organisations as applicable). You should briefly describe how your project will deal
with the following groups who suffer from discrimination and may be represented
within the target group you have identified for your project activities:

men or women (or both);

ethnic minorities and those who are discriminated against because of their race;
people with a disability;
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lesbians and gay men;

people who are discriminated against because of religious belief; and

other excluded groups such as refugees, ex-offenders, people addicted to drugs
and alcohol, and travellers.

Please also describe the needs of, and barriers faced by, your beneficiaries and how
these will be dealt with, and how your project plans to empower its beneficiaries.
Support measures for the specific needs of all beneficiaries should be described,
including translation and interpretation, creche facilities, physical access to buildings,
aids and adaptations for disabled people and other means through which you will
enable beneficiaries to fully participate in project activities.

You must demonstrate your experience of delivering services to your target groups. It
may be appropriate for you to involve organisations which are owned, controlled or
operated by equalities target groups in your partnership to ensure targeted and
appropriate provision.

Further guidance and useful questions that will help you think through these issues

with  regard to your project <can be found at: http://www.go-
london.gov.uk/european_structural funds/objective 3/index.asp

At the end of the Tender Proposal form you will find an accompanying
guestionnaire relating to the issues raised in this section, which you should
complete. This will help you to think through your answer to this question.
Failure to complete the questionnaire will mean that your project fails
eligibility.

Section 7.B: SUSTAINABLE DEVELOPMENT A: 6 POINTS

This question asks you to illustrate how your project has integrated
sustainable development by making positive and relevant contributions to
each of its social, economic and environmental elements.

Sustainable development is a process that seeks to ensure a better quality of life for
everyone, now and for generations to come, by integrating social, environmental and
economic considerations equally into everything we do. It recognises that social,
economic and environmental issues are interdependent and therefore activity in one
of these areas should not be pursued in isolation but with consideration for each of
the other areas as well.

Sustainable development is being increasingly integrated into Government policy,
legislation and decision-making to help deliver a better quality of life for everyone. To
guide this process the UK Government has developed the UK’'s Strategy for
Sustainable Development “A Better Quality of Life” (http://www.sustainable-
development.gov.uk) and the London Sustainable Development Commission,
established by the Mayor of London, has produced a Sustainable Development
Framework for London (http://www.london.gov.uk/londonissues/sustainability.jsp).

There is also an increasing recognition of the need to integrate sustainable
development within education and skills provision, to equip people with the skills and
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knowledge they need to integrate sustainable development into their work and home
lives. Please refer to the Department for Education and Skills “Sustainable
Development Action Plan for Education & Skills”
(www.dfes.gov.uk/sd/docs/SDactionplan.pdf).

With respect to the European Social Fund, there is now an increasing emphasis on
sustainable development. The Objective 3 Programme has taken the three elements
of sustainable development and defined them as follows:

- Social: Providing the opportunities for everyone to fulfil their potential
Environment:  Environmental protection and enhancement through the
delivery of projects
Economic: Providing the skills that businesses both demand and require —
now and in the future

To integrate sustainable development you must consider all 3 of its elements and not
just one or two of them. Further explanation on each element is given below.

Social: Providing the opportunities for everyone to fulfil their potential

This focuses on tackling social exclusion, widening participation in education and
training, and helping to overcome the various barriers (be they social, economic or
cultural) that prevent people becoming involved. You should research and analyse
the particular needs and issues relevant to your target group, such as socially
excluded or long-term unemployed, and identify the steps or actions you need to take
to engage with these groups. A diverse range of approaches may be required, and
partnerships with other organisations may be necessary to enable effective and
targeted intervention.

Environmental: Environmental protection and enhancement through the
delivery of projects
There are 2 main areas where you can contribute to the environment as part of your
project:
- Consider how you address environmental issues in your organisation
especially in the areas of energy, water, waste, procurement and transport
and how will this influence how you deliver your project. For example promote
use of public transport and minimise car use, use energy efficient equipment,
reduce waste through increased use of ICT and reduce the impact of your
resource use by signing up to the Mayor's Green Procurement code and
buying environmentally friendly goods.
Integration of environmental issues into course content to raise the general
level of awareness and understanding of environmental issues and how they
can be addressed. For example, including information on sustainable design
and construction techniques on construction courses; developing social,
practical and team working skills through enhancement of a local green space
or a river clean-up.

Economic: Providing the skills that businesses both demand and require — now
and in the future

This involves ensuring that labour supply meets demand by addressing the generic
and specific skill shortages that exist in the labour market, and ensuring an adaptable
and flexible labour market. It also includes a focus on the future skill needs of
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businesses by identifying growth sectors and highlighting the increasing importance
of addressing sustainability and environmental management within business. You
should also consider how environmental management issues could be integrated into
training provision aimed at employers and employees.

For many Objective 3 projects, the social and economic elements of sustainable
development are likely to be the primary focus of your project. Use this section to
demonstrate what you are doing to address these elements and how you can
address environmental issues in delivering your project.

At the end of the Tender Proposal form you will find an accompanying
guestionnaire relating to the issues raised in this section, which you should
complete. This will help you to think through your answer to this question.
Failure to complete the questionnaire will mean that your project fails
eligibility.

Section 7.C: INFORMATION AND COMMUNICATION TECHNOLOGY (ICT) A: 2 POINTS

You need to show how ICT will be used in the design, delivery and management of
the project. Emphasis should be placed on how ICT will be used to improve the
efficiency and quality of the project. You should also consider how the project would
address barriers to ICT skills development.

Section 7.D: HEALTH AND SAFETY E

How will you as the lead organisation ensure that project activity meets health and
safety legislation? If partners are delivering parts of the activity you must ensure that
they demonstrate how they will manage health and safety issues on a day to day
basis within this section.

At the end of the Tender Proposal form you will find an accompanying
guestionnaire relating to the issues raised in this section, which you should
complete. Failure to complete the questionnaire will mean that your project
fails eligibility.

CERTIFICATION AND COMPLETING AND SIGNING YOUR PROPOSAL FORM E
Please sign your proposal form after reading the certification. The person who
completed the application form should sign and date it as well as an authorised

senior officer of the applicant organisation e.g. the Chief Executive.

Complete the checklist at the beginning of this Guidance Note to ensure that you
have included all the required information and documents.

NB If your proposal is not signed and dated (x2), and if all the required
documentation is not submitted, your proposal will fail eligibility.
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ANNEX 1: GUIDANCE ON USING THE ELECTRONIC VERSION OF THE TENDER
PROPOSAL FORM

It is essential that you read this guidance note carefully before beginning work on
your file. The electronic version of the Tender Proposal Form is provided for use with
Microsoft Word, versions 97, 2000, XP (sometimes known as 2002) and 2003.

WORD Macro Virus Protection

This template contains macros to aid functionality. For example, some calculations are
carried out when you double click the mouse on an indicated area of text that activates a
macro.

When you save the template or create a document from it, you may receive a warning that
the file contains macros and that they may contain harmful viruses. If you receive this
warning, choose the option that Enables Macros as the template has been thoroughly virus
checked.

If you are using Word 2000, XP or 2003, the macros may be automatically disabled
when you use the template and the functionality of the macros will be lost. In this
case, you will need to modify your WORD Macro Security Level before beginning work
on your file:

1. Choose Macros from the Tools menu and choose Security from the pop out menu to
display the Security dialog box.

2. Click the Security Level tab if necessary and then set the Security Level to Medium and
click OK.

In future, you will receive the warning as described above when you use the template. You
will also receive the warning when you attempt to open any other files that contain macros,
customised toolbars, menus or shortcuts — take care when opening these as they may
contain harmful viruses. You may want to set your Macro Security Level back to High when
you have finished completing and printing the form.

Saving the template
The template is called:

LSC London East ESF O3 Programme Tender Proposal Form

You should save or copy the file to the relevant template directory on your system. To find
out where your template files are normally stored:

start Word;

select Options from the Tools menu;

select the File Locations tab; and

look at the location of User Templates.
If you are not sure or cannot locate the template directory, please ask for technical help
within your organisation.

Creating a document from the template

To create a document, open Word and select New from the File menu. A list of templates will
be displayed. Select the LSC London East ESF O3 Programme Tender Proposal Form
template. A new document based on the template will be displayed on the screen. Name
your document and save it to your working directory. We strongly recommend that you do
not save it to the a: drive (floppy disk drive). You are now ready to begin entering your text.
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Protected and unprotected sections

Most sections of the documents have been protected. This means that you will only be able
to enter data in the relevant fields, and you will not be able to alter the existing format or text
of the form; however, some sections of the form are unprotected. You will be advised when
you are entering or leaving the unprotected sections by a hidden text prompt at the end of
the section.

To view the hidden text, which is coloured red, you need to activate the Show hidden text
option in Word. To do this, choose Options from the Tools menu and select the View tab.
The appearance of the dialog box will vary between different versions of Word, but you need
to put a mark in the check box for Show hidden text. You can also show hidden text by
clicking the Show/Hide toolbar button, shown below. This will also show other hidden
elements in the document.

Entering data

The template creates changes in the behaviour of certain keys. It is important that you read
the following section carefully and are familiar with these changes before you attempt to
enter data.

In protected sections, many menu commands and toolbar buttons are disabled. The red
and green underlines used by Word to indicate Spelling or Grammar queries do not appear
and the spell checker is disabled.

You can move forwards from field to field using the Tab key and backwards from field to field
using Shift + Tab. You can also use the scroll bars and click the mouse in a field. To enter
data, you can either type directly in a field, or, in the case of the Check Box (tick) fields, add
or remove a mark with the spacebar, x key, or by clicking with the mouse. You can enter
carriage returns within text fields in the normal way.

It is also possible to Paste text, but not tables, into the document from other Word files. To
Paste copied text from another document into a field in a protected section, click in the field
and use the Control + V keyboard shortcut. Where appropriate, tables in the document will
expand to fit extra typed or Pasted text. If a table goes over a page, a new page will be
created automatically and the table heading will be repeated on the new page.

In unprotected sections, normal Word functionality applies. The red and green underlines
used by Word to indicate Spelling or Grammar queries do not appear but the spell checker is
enabled.

Extra care is required as otherwise you may accidentally make changes to the text or form
layout in these sections. The unprotected text entry fields have been created as normal Word
tables. Press the Tab key in the last cell of the table to add additional rows as required and
follow the instructions in the document for calculating totals.
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A summary of guidance in the protected sections is given below:

To Press

Enter data in a field and move to the next field Tab

Move to a previous field Shift + Tab

Select or clear a check(tick) box Space bar, or x key or click the
mouse

Insert a tab character in a text form field or in a Ctrl + Tab key

table

Use a drop-down menu Click with the mouse

Paste text that has been copied from another Click in the field and press Control +

document V on the keyboard

Before printing the form

As a final check that all fields and calculations in your document are updated, select Options
from the Tools menu and select the Print tab. Make sure you check (tick) the Update fields
option.

Printing your form
You can print out single pages or the entire form using the normal Word print routine. Please
print your form single-sided.

Please remember to save your work frequently and create regular backups.

Note: When closing your document, Word may display a dialog box asking you if you want to
save changes to the template. If so, click the ‘No’ button.
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